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BAB IV 

HASIL DAN PEMBAHASAN 

Pada bab ini peneliti akan membahas dan memaparkan hasil penelitian 

tentang Efektivitas penerapan pendekatan inkuiri terhadap keterampilan berbicara 

siswa SMPN 1 Pamekasan. Penyajian data pada bab ini meliputi Hasil dan 

Peembahasan. 

A. Hasil Penelitian 

Pada sub bab ini peneliti akan memaparkan tentang hasil penelitian yang 

dilakukan untuk menjawab persoalan dalam rumusan masalah yang telah 

ditentukan. Hasil penelitian pada sub bab ini meliputi deskripsi hasil penelitian dan 

pembuktian hipotesis. 

1. Deskripsi Hasil Penelitian 

Penelitian ini dilakukan di SMPN 1 Pamekasan pada tanggal 11 

Februari 2023 sampai 13 Maret 2023. Tujuan dari penelitian ini adalah untuk  

mengukur Efektivitas penerapan pendekatan inkuiri terhadap keterampilan 

berbicara siswa SMPN 1 Pamekasan. Subjek yang digunakan dalam 

penelitian ini adalah siswa kelas VIII C sebagai kelas eksperimen dan kelas 

VIII D sebagai kelas kontrol. 

Sebelum melakukan penelitian peneliti mengumpulkan berbagai 

informasi pendukung yang dibutuhkan dalam penelitian ini. Sebagai 

informasi awal pada kegiatan penelitian ini akan disajikan data jumlah siswa 

pada lima tahun terakhir dan jumlah rombongan belajar pada saat dilakukan 

penelitian. Penelitian ini dilaksanakan pada semester genap pada tahun ajaran 

2022/2023. 
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Berikut ini disajikan secara ringkas tabel jumlah siswa SMPN 1 

Pamekasan. 

Tabel 4. 1 Jumlah Siswa 5 Tahun Terakhir SMPN 1 Pamekasan 

Tahun 
Jumlah Pendaftar 

Siswa Baru 

Jumlah Siswa 

yang diterima 

NUN diterima 

2018/2019 292 292 Zonasi 

2019/2020 320 320 Zonasi 

2020/2021 338 320 Zonasi Prestasi 

2021/2022 317 317 Zonasi Prestasi 

2022/2023 321 321 Zonasi Prestasi 

Sumber: SMPN 1 Pamekasan 

Berikut ini disajikan secara ringkas tabel jumlah rombongan belajar 

tahun 2022/2023 SMPN 1 Pamekasan. 

Tabel 4. 2 Jumlah Rombel Tahun 2022/2023 

No Uraian Detail Jumlah Total 

1 Kelas VII 
L 144 

321 
P 177 

2 Kelas VIII 
L 160 

315 
P 155 

3 Kelas IX 
L 151 

318 
P 167 

Jumlah Peserta Didik 954 

Sumber: SMPN 1 Pamekasan 

Penentuan sampel sebagai subjek dalam penelitian ini dipengaruhi oleh 

perizinan yang diberikan oleh pihak sekolah kepada peneliti. Sampel yang 

menjadi subjek pada penelitian ini adalah siswa kelas VIII C sebagai kelas 

eksperimen dengan jumlah 32 siswa dan kelas VIII D sebagai kelas kontrol 

dengan jumlah 32 siswa. Adapun untuk mengetahui nama-nama siswa yang 

menjadi subjek penelitian ini dapat dilihat pada lampiran tabel nama-nama 

siswa subjek penelitan. 

Kegiatan penelitian ini dilakukan untuk mencari dan mengetahui data 

pada keterampilan berbicara siswa SMPN 1 Pamekasan. Materi yang dipakai 
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dalam melaksanakan penelitian ini adalah teks persuasi pada pembelajaran 

bahasa Indonesia bab ketujuh pada semester genap. Pelaksanaan penelitian 

disesuaikan dengan materi yang aakaan diajarkan oleh guru pengajar. 

Pemilihan materi teks persuasif dikarenakan isi materi terdapat kompetensi 

dasar yang berhubungan dengan penilaian keterampilan berbicara. 

Adapun kompetensi dasar yang terdapat dalam materi teks persuasi 

adalah sebagai berikut. 

3.13 Mengidentifikasi jenis saran, ajakan, arahan, dan pertimbangan 

tentang berbagai hal positif atas permasalahan aktual dari teks 

persuasi (lingkungan hidup, kondisi sosial, dan/atau keragaman 

budaya) yang didengar dan dibaca. 

4.13 Menyimpulkan isi saran, ajakan, arahan, pertimbangan tentang 

berbaga hal positif permasalahan aktual dari teks persuasi 

(lingkungan hidup, kondisi sosial, dan/atau keragaman budaya) yang 

didengar dan dibaca 

3.14 Menelaah struktur dan kebahasaan teks persuasi yang berupa saran, 

ajakan, dan pertimbangan tentang berbagai permasalahan aktual 

(lingkungan hidup, kondisi sosial, dan/atau keragaman budaya, dll) 

dari berbagai sumber yang didengar dan dibaca 

4.14 Menyajikan teks persuasi (saran, ajakan, arahan, dan pertimbangan) 

secara tulis dan lisan dengan memperhatikan struktur, kebahasaan, 

atau aspek lisan 

 

Setiap kompetensi dasar materi yang ditempuh dalam penelitian ini 

untuk kelas eksperimen menggunakan pembelajaran berbasis inkuiri dan 
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untuk kelas kontrol menggunakan konvensional seperti yang diterapkan oleh 

guru pengajar di SMPN 1 Pamekasan. 

Keterampilan berbicara yang kompleks menjadi bahan penilaian 

sebagai data dalam penelitian terdapat pada kompetensi dasar 4.14 yakni 

setelah siswa membuat teks persuasi kemudian siswa mempresentasikan hasil 

karya yang telah dibuat didepan kelas dan siswa yang lain. Peneliti dalam hal 

ini melakukan penilaian sesuai dengan penampilan siswa secara objektif. 

Berdasarkan pengumpulan data yang telah dilakukan di SMPN 1 

Pamekasan, data yang berhasil dikumpulkan dari kegiatan penelitian adalah 

nilai keterampilan berbicara siswa. Nilai diambil dari presentasi siswa pada 

materi teks persuasif dengan menggunakan rubrik penilaian keterampilan 

berbicara. Berikut ini disajikan tabel hasil penelitian dari kelas eksperimen 

dan kelas kontrol 

Tabel 4. 3 Hasil Penelitian Kelas Eksperimen 

No Nama Siswa 
Aspek Penilaian 

Skor Nilai 
Y1 Y2 Y3 Y4 Y5 Y6 Y7 

1 
Adinda Orryza 

Novia Putri Syafina 
3 3 3 4 4 4 3 24 86 

2 Adrian Afrieliadi 3 3 4 2 3 4 3 22 79 

3 
Alfiana Zakiyatul 

Fikri 
4 4 4 4 4 3 4 27 96 

4 Alief Nawabil 3 3 2 3 3 3 3 20 71 

5 
Alyssa Risma 

Paramitha 
4 2 3 3 3 4 3 22 79 

6 Amelia Heriyanto 3 3 2 3 3 3 3 20 71 

7 Anggi Margareta 3 2 3 3 3 3 3 20 71 

8 
Annisa Cahya 

Ramadhani 
3 2 3 3 3 3 3 20 71 

9 Asraful Miftah 3 4 3 3 4 3 3 23 82 

10 
Bima Satria Putra 

Rismawan 
3 4 3 3 3 3 4 23 82 

11 
Bintang Davina 

Adinda Joanita 
3 3 3 4 3 3 3 22 79 
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12 
Cahyani Dwi 

Kartika 
3 4 4 4 3 3 3 24 86 

13 
Chiko Hardelio 

Taher 
3 3 3 3 3 3 3 21 75 

14 
Elvina Maulida 

Putri 
3 4 3 3 3 3 3 22 79 

15 Faradillah Fajrin 3 3 4 2 3 3 2 20 71 

16 
Febrian Hadi 

Sutrisno 
4 4 3 4 4 4 4 27 96 

17 
Fiyhima Ainani 

Tajriyan 
3 3 3 3 4 3 4 23 82 

18 
Habibie Nur 

Syafarudin 
2 4 3 3 3 3 3 21 75 

19 Heri Romadhoni 3 3 4 3 3 3 3 22 79 

20 Intan Yuliyana 3 4 3 3 3 3 3 22 79 

21 
Jenius Yafnain 

Syah Putri 
3 3 3 3 3 3 3 21 75 

22 
Lovely Ramadhani 

Mixta 
3 3 3 4 3 3 3 22 79 

23 
Luna Zahratus 

Shita 
3 2 3 3 3 3 3 20 71 

24 
Milzi Alifia 

Maulida 
3 3 3 3 3 3 3 21 75 

25 
Moh Firman 

Fahriyanto 
4 4 3 3 3 4 3 24 86 

26 
Mohammad Alvi 

Syahrin 
4 4 4 4 3 4 4 27 96 

27 
Mohammad Nurul 

Hidayat 
4 4 4 4 3 3 4 26 93 

28 Nabila Putri Utami 3 4 4 3 3 3 3 23 82 

29 
Naufal Putra 

Herdiansyah 
4 3 3 4 4 4 4 26 93 

30 
Naura Yasmita Dwi 

Septiandina 
3 3 3 3 3 3 3 21 75 

31 Shifa Aulia Natasya 4 3 4 3 3 3 3 23 82 

32 
Tantri Dinda 

Kurnia 
3 4 4 4 3 3 3 24 86 

          2582 

 

Tabel 4. 4 Hasil Penelitian Kelas Kontrol 

No Nama Siswa 
Aspek Penilaian 

Skor Nilai 
Y1 Y2 Y3 Y4 Y5 Y6 Y7 

1 
Ahsan Akbar 

Firmansyah 
3 2 2 2 3 4 3 19 68 

2 
Aizza Rahmatin 

Nur Nadin 
4 3 3 2 3 4 2 21 75 
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3 Akhdan Aimar 3 4 3 4 2 3 3 22 79 

4 
Alvian Pratama 

Ramadhani 
2 2 3 2 3 3 2 17 61 

5 
Amanda Amalia 

Azizah 
3 2 2 3 3 3 3 19 68 

6 Ekania Nurul Fitria 3 4 3 4 2 3 3 22 79 

7 Farika Ramadania 4 3 3 2 3 4 2 21 75 

8 Ferdy Megiyanto 2 2 3 2 3 3 2 17 61 

9 
Gilang Akbar 

Syahputra Nasso 
3 4 4 4 4 4 3 26 93 

10 Holizatul Amalia 3 4 3 4 3 3 3 23 82 

11 
Jevian Stya 

Pratama 
3 4 4 4 3 3 2 23 82 

12 
Moh. Fiki Alan 

Fajri 
3 3 3 3 3 3 2 20 71 

13 
Mohammad Iqbal 

Ristriaanto 
3 3 3 3 3 3 2 20 71 

14 
Mohammad Rifki 

Fajri Maulidi 
3 2 3 2 4 4 2 20 71 

15 
Muhammad Fachry 

Annaufal 
3 4 2 4 3 3 2 21 75 

16 
Muhammad Faizal 

Alfajri 
3 2 3 3 3 3 2 19 68 

17 
Muhammad Rif’an 

Darul Adzkiyah 
3 4 2 4 3 3 2 21 75 

18 Nadhifa Maulidia 3 2 2 3 4 3 2 19 68 

19 Nadya Zahwa 3 4 4 4 4 3 4 26 93 

20 Nafil Beryl Fairuz 3 2 3 3 3 3 2 19 68 

21 
Raja Vahri 

Firmansyah 
2 3 4 3 3 4 2 21 75 

22 Raka Tri Ramdani 3 2 2 4 3 3 2 19 68 

23 
Rakha Naufal 

Ubaidillah 
3 2 3 2 3 3 3 19 68 

24 Reviana Zahra 4 3 4 3 4 3 3 24 86 

25 Riana Maulidia 3 2 3 2 3 3 3 19 68 

26 
Rina Dwi 

Ramadanti 
3 2 4 3 4 4 3 23 82 

27 
Sabrina Aura Putri 

Anam 
4 4 4 4 4 3 4 27 96 

28 Sultan Khalik Huda 3 2 3 2 4 4 2 20 71 

29 
Syakinah Adelia 

Putri 
3 2 4 3 4 4 3 23 82 

30 
Yoga Adhyasta 

Zahran 
3 3 3 3 3 3 2 20 71 

31 
Yunia Mamluatul 

Hasanah 
2 2 3 3 4 4 3 21 75 
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2. Pembuktian Hipotesis 

Pada sub bab ini akan dipaparkan hasil pembutian hipotesis yang 

meliputi hasil uji normalitas, hasil uji homogenitas, hasil uji statistik non 

parametrik, dan signifikansi besar pengaruh. 

a. Uji Normalitas 

Uji Normalitas merupakan proses pembuktian yang dilakukan dengan 

tujuan untuk mengetahui apakah data diperoleh dari populasi yang 

berdistribusi normal atau tidak.62 Pada penelitian ini pengujian normalitas 

data dilakukan terhadap masing-masing kelas eksperimen dan kelas kontrol. 

Data diambil dari nilai keterampilan beribicara kelas eksperimen dan kelas 

kontrol. Uji normalitas yang digunakan pada penelitian ini adalah 

Kolmogorolov-Smirnov. Nilai taraf signifikansi digunakan oleh peneliti 

adalah sebesar 5% atau 0,05. 

Dasar pengambilan keputusan dalam uji normalitas Kormogorolov-

Smirnov yakni; Jika signifikansi menunjukkan > 0,05 maka sampel berasal 

dari populasi yang berdistribusi normal. Jika signifikansi menunjukkan <0,05 

maka sampel berasal dari populasi yang berdistribusi tidak normal.63 

Berdasarkan hal tersebut maka perumusan dasar pengambilan 

keputusan dalam uji normalitas penelitian ini adalah sebagai berikut: 

a. Jika nilai signifikansi (Sig.) > 0,05 maka data berdistribusi normal. 

b. Jika nilai signifikansi (Sig.) < 0,05 maka data berdistribusi tidak normal. 

 

                                                 
62 Nuryadi dkk, Dasar-Dasar Statistik Penelitian (Yogyakarta:  Sibuku Media, 2017). h. 79 
63 Juliansyah, Metodologi Penelitian: Skripsi, Tesis, Disertasi & Karya Ilmiah (Jakarta: Kencana 

Prenada Media Group, 2017). h. 178 
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Adapun langkah-langkah dalam uji normalitas menggunakan aplikasi 

SPSS 20 adalah sebagai berikut: 

1. Buat lembar kerja baru klik menu File > New > Data 

2. Klik Tab Variable View dan buat variabel pertama dengan nama Hasil 

Keterampilan Berbicara dan variabel kedua buat dengan nama kelas. 

 Name: Hasil  Name: Kelas 

 Type: Numeric  Type: Numeric 

 Width: 8  Width: 8 

 Decimal: 0  Decimal: 0 

 Label: Hasil Keterampilan  Label: Kelas 

 Value: None  Value: None 

 Missing: None  Missing: None 

 Columns: 8  Columns: 8 

 Align: Right  Align: Right 

 Measure: Scale  Measure: Measure 

 

3. Klik Tab Data View dan isikan data sesuai dengan variabel yang telah 

dibuat. 

4. Setelah itu, klik Analyze > Descriptive Statistic > Explore 

5. Kemudian masukkan hasil pada kolom Dependent List dan kelas pada 

kolom Factor List 

6. Kemudian tab Plots dan beri tanda centang pada None dan Normality 

Plots wit Test 

7. Kemudian klik Continue dan OK  
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Berikut merupakan hasil uji normalitas data kelas eksperimen dan data 

kelas kontrol menggunakan aplikasi SPSS 20. 

Tabel 4. 5 Uji Normalitas 

Test Of Normality 

 
Kelas Kolmogrov-

Smirnova 

Shapiro-Wilk 

 Statistic df Sig. Statistic df Sig. 

Hasil Keterampilan 

Berbicara 

Kelas 

Eksperimen 
.152 32 .059 .904 32 .008 

Kelas Kontrol .177 31 .014 .917 31 .019 

a.Lilliefors Significance Correction 

 

Hasil uji normalitas nilai signifikansi (Sig.) yang diperoleh kelas 

eksperimen yakni 0,059. Sedangkan Nilai signifikansi (Sig.) yang diperoleh 

kelas kontrol yakni 0,014. Dengaan demikian dapat disimpulkan bahwa data 

kelompok berdistribusi tidak normal. Hal itu terjadi karena signifikansi nilai 

kelas kontrol (Sig.) 0,014 < 0,05 (tidak normal) meskipun signifikansi nilai 

kelas eksperimen (Sig.) 0,059 > 0,05 (normal). 

Berdasarkan pada hasil tersebut maka uji statistik parametrik tidak 

dapat dilanjutkan dan sebagai alternatif uji hipotesis yang dapat digunakan 

adalah uji statistik non-parametrik dengan menggunakan uji Mann-Whitney. 

b. Uji Homogenitas 

Uji homogenitas merupakan sebuah proses uji statistik yang dilakukan 

dengan tujuan untuk mengetahui kelompok data bersumber dari populasi 

yang mempunyai varians sama. Uji ini juga dimaksudkan untuk meyakinkan 

bahwa data berasal dari populasi yang tidak jauh berbeda keragamannya. 64 

                                                 
64 Nuryadi dkk. 89 
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Dalam perhitungan uji homogenitas, dasar pengambilan keputusan  uji 

homogenitas adalah jika nilai signifikansi menunjukkan < 0,05 maka sata 

bersifat tidak homogen, hal itu pun berlaku sebaliknya.65 

Dasar pengambilan keputusan dalam uji homogenitas penelitian ini, 

yakni; 

a. Jika nilai signifikansi (Sig.) pada Based on Mean > 0,05 maka data bersifat 

homogen. 

b. Jika nilai signifikansi (Sig.) pada Based on Mean < 0,05 maka data bersifat 

tidak homogen. 

Tabel 4. 6 Uji Homogenitas 

Test Of Homogenity of Variance 

 Levene 

Statistic 

df1 df2 Sig. 

Hasil Keterampilan 

Berbicara 

Based on Mean .193 1 61 .662 

Based on Median .329 1 61 .569 

Based on Median and with adjusted df .329 1 60.803 .569 

Based on trimmed mean .226 1 61 .636 

 

Hasil uji homogenitas menggunakan aplikasi SPSS 20 menunjukkan 

nilai signifikansi (Sig.) Based on Mean yang diperoleh adalah 0.662 > 0,05 

maka data yang diperoleh homogen. Dengan demikian dapat disimpulkan 

bahwa data bersifat homoogen dan memiliki varians yang sama dengan 

keragaman yang tidak jauh berbeda. 

Meskipun demikian data tidak bisa dilanjutkan pada tes statistik 

parametrik dikarenakan normalitas data tidak memenuhi syarat uji, walaupun 

                                                 
65 Dodit Aditya Setyawan, Petunjuk Praktikum Uji Normalitas Dan Uji Homogenitas Data Dengan 

SPSS (Jawa Tengah: Tahta Media Group, 2021). 
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data bersifat homoogen. Alternatif uji hipotesis statistik yang digunakan 

adalah uji statistik non-parametrik dengan menggunakan uji Mann-Whitney. 

c. Uji Hipotesis 

Uji hipotesis dipakai untuk mengetahui apakah keterampilan berbicara 

kelas eksperimen berbeda secara signifikan (Sig.) dengan keterampilan 

berbicara pada kelas kontrol. Pada uji hipotesis ini peneliti menggunakan uji 

statistik non-parametrik yakni uji Mann-Whitney dengan menggunakan 

aplikasi SPSS 20. Uji Mann-Whitney dilakukan untuk mengetahui perbedaan 

rata-rata dua sampel atau kelompok data yang independen jika data pada salah 

satu atau kedua kelompok sampel tidak memenuhi uji normalitas.66 Uji dua 

sampel pada statistik non parametrik Mann Whitney mempunyai tujuan yang 

sama dengan uji t pada statistik parametrik yakni untuk mengetahui apakah 

data beraasal dari populasi yang sama.67 

Adapun hipotesis yang dipakai dan diajukan dalam penelitian ini yakni 

sebagai berikut. 

Ha = Pendekatan inkuiri efektif dalam pembelajaran bahasa Indonesia 

terhadap keterampilan berbicara siswa SMPN 1 Pamekasan 

Taraf signifikansi perhitungan uji Mann Whitney berada pada rentang 

signifikansi 5% atau 0,05.68 Dasar pengambilan keputusan yang digunakan 

dalam uji Mann-Whitney berdasarkan probabilitas yaitu:  

                                                 
66 Sundayana. h. 153 
67 Singgih Santoso, Statistik Nonparametrik (Jakarta: Media Komputindo, 2010). h. 117 
68 Bunnaya Syifa Qolby, ‘Uji Mann Whitney Dalam Statistika Non Parametrik’, Academia Edu 

(Universitas Pasundan, 2014). 
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b. Jika nilai signifikansi Sig. (2-tailed) > 0,05 maka Ho diterima 

c. Jika nilai signifikansi Sig. (2-tailed) < 0,05 maka Ho ditolak.69 

Langkah-langkah dalam uji Mann Whitney dengan menggunakan SPSS 

20 adalah sebagai berikut: 

1. Buat lembar kerja baru klik menu File > New > Data 

2. Klik Tab Variable View dan buat variabel pertama dengan nama Hasil 

Keterampilan Berbicara dan variabel kedua buat dengan nama kelas. 

 Name: Hasil  Name: Kelas 

 Type: Numeric  Type: Numeric 

 Width: 8  Width: 8 

 Decimal: 0  Decimal: 0 

 Label: Hasil Keterampilan  Label: Kelas 

 Value: None  Value: None 

 Missing: None  Missing: None 

 Columns: 8  Columns: 8 

 Align: Right  Align: Right 

 Measure: Scale  Measure: Measure 

 

3. Klik Tab Data View dan isikan data sesuai dengan variabel yang telah 

dibuat. 

4. Setelah itu, klik Analyze > Nonparametric Tests > Legacy Dialogs > 

2 Independent Samples 

                                                 
69 Singgih Santoso, Mengatasi Berbagai Masalah Statistik Dengan SPSS (Jakarta: Elex Media 

Computindo, 2005). 
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5. Masukkan Hasil keterampilan berbicara pada kotak Test Variabel List 

6. Masukkan Kelas pada kotak Grouping Variabel 

7. Pilih Test Type pilih Mann Whitney U 

8. Klik tombol Define Grouping, kemudian isi Group 1 dengan 1 dan 

Group 2 dengan 2 

9. Klik Continue dan OK 

Tabel 4. 7 Uji Hipotesis 

Test Statisticsa 

 Hasil 

Keterampilan 

Berbicara 

Mann-Whitney U 288.500 

Wilcoxon W 784.500 

Z -2.881 

Asymp. Sig. (2-tailed) .004 

a.Grouping Variabel: Kelas 

  

Berdasarkan hasil uji hipotesis statistik Mann-Whitney dengan 

menggunakan aplikasi SPSS 20 yang dilakukan pada nilai akhir kelas 

eksperimen dan kelas kontrol didapatkan nilai Asymp. Sig. (2-tailed) 0.004 < 

0,05. Dengan demikian nilai Sig. (2-tailed) 0.004 lebih kecil dari 0,05 maka 

Ha diterima dan Ho ditolak. Maka dari itu dapat diartikan bahwa penerapan 

pendekatan inkuiri efektif dalam pembelajaran bahasa Indonesia terhadap 

keterampilan berbicara siswa SMPN 1 Pamekasan. 

d. Menentukan Besar Pengaruh 

Upaya untuk mengetahui besar efektivitas penerapan pendekatan 

inkuiri terhadap keterampilan berbicara siswa SMPN 1 Pamekasan yang 

terdapat pada penelitian ini adalah dengan mengukur Effet Size. Effect Size 

yag digunakan pada penelitian ini adalah rumus Cohen’s d. 



53 

 

 

 

Edna dkk, memaparkan bahwa Effect Size adalah metode statistik yang 

dipakai untuk mengetahui rerata dan standar treatment yang digunakan pada 

sebuah studi atau penelitian. 70 

Rentangan nilai perhitungan effect size pada rumus cohen’s d adalah 

sebagai berikut.71 

Tabel 4. 8 Rentangan Nilai Effect Size 

Nilai Interpretasi 

0 - 0.20 Lemah 

0.21 – 0.50 Kecil 

0.51 – 1.00 Sedang 

>1.00 Besar 

 

Berikut ini disajikan perhitungan effect size menggunakan rumus 

cohen’s. 

Rumus Cohen’s 𝒅 =
𝑴𝟏−𝑴𝟐

𝑺𝒈𝒂𝒃
 

Dengan rumus 𝑺𝒈𝒂𝒃 = √
(𝒏𝟏−𝟏)𝑺𝒅𝟏

𝟐=(𝒏𝟏−𝟏)𝑺𝒅𝟐
𝟐

𝒏𝟏+𝒏𝟐−𝟐
 

𝒅 =
𝑴𝟏 −𝑴𝟐

√
(𝒏𝟏 − 𝟏)𝑺𝒅𝟏

𝟐 + (𝒏𝟏 − 𝟏)𝑺𝒅𝟐
𝟐

𝒏𝟏+𝒏𝟐 − 𝟐

 

𝒅 =
𝟖𝟎. 𝟔𝟗 − 𝟕𝟓

√(𝟑𝟐 − 𝟏)𝟕. 𝟔𝟓𝟐 + (𝟑𝟏 − 𝟏)𝟖. 𝟔𝟐𝟐

𝟑𝟐 + 𝟑𝟏 − 𝟐

 

𝒅 =
𝟓. 𝟔𝟗

√(𝟑𝟏)𝟓𝟖. 𝟓𝟐 + (𝟑𝟎)𝟕𝟒. 𝟐𝟓
𝟔𝟏

 

                                                 
70 Edna B Foa dan Keane Terence M, Effective Treatments for PTSD, 2nd edn (Britania Raya: 

Guilford Publications, 2009). 
71 Suparman, Dadang Juandi, dan Maximus Tamur, ‘Problem Based Learning for Mathematichal 

Critical Thinking Skills: A Meta-Analysis', Journal of Human University, 48.2 (2021). h. 136 
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Dari hasil perhitungan Effect Size Uji Mann Whitney didapatkan 

sebesar 0,69 ketika diinterpretasikan dengan kriteria rentangan nilai cohen’s 

d didapatkan bahwa 0.69 termasuk dalam kategori sedang. Dengan demikian 

dapat disimpulkan bahwa benar terdapat efektivitas penerapan pendekatan 

inkuiri terhadap keterampilan berbicara siswa SMPN 1 Pamekasan dengan 

rentang nilai 0.69 kategori sedang. 

B. Pembahasan 

Setelah pembuktian hipotesis dilakukan maka selanjutnya akan dibahas 

tentang Efektivitas penerapan pendekatan inkuiri terhadap keterampilan berbicara 

siswa SMPN 1 Pamekasan sesuai dengan hasil penelitian yang telah dipaparkan 

diatas. 

1. Penerapan pendekatan inkuiri terhadap ketarampilan berbicara siswa 

SMPN 1 Pamekasan. 

Pendekatan inkuiri merupakan rangkaian kegiatan yang diterapkan oleh guru 

dalam proses pembelajaran yang mana pada kegiatan pembelajaran guru 

melibatkan siswa untuk dapat berpikir kritis dan siswa diharapkan mampu 

memecahkan segala sistematika yang ada dalam pembelajaran.  
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Penerapan pendekatan inkuiri adalah bagian dari tingkat berpikir tinggi. 

Karena pada proses pembelajaran dengan pendekatan ini siswa dituntut untuk dapat 

menemukan sendiri jawaban dari segala problematika dalam pembelajaran. Pada 

proses kegiatan belajar mengajar dengan menggunakan pendekatan inkuiri tidak 

hanya mengembangkan kemampuan intelektual namun juga seluruh potensi yang 

ada seperti pengembangan emosional dan keterampilan. 

Kegiatan pembelajaran dengan menggunakan pendekatan inkuiri diawali 

dengan mengamati sebagai upaya dalam memahami konsep.  Pada kegiatan inkuiri 

siklus yang umumnya dilakukan adalah proses pengamatan, proses bertanya, proses 

penyelidikan, proses analisis dan proses perumusan teori secara individu atau 

kelompok.72 

Menilik penelitian yang sudah dilakukan, pendekatan inkuiri sangat cocok 

untuk diterapkan pada pembelajaran materi bahasa Indonesia yaitu dalam 

mengembangkan keterampilan bernicara siswa. Materi ajar yang dipilih pada 

penelitian ini adalah pada teks persuasi.  

Materi teks persuasi merupakan materi pelajaran bahasa Indonesia untuk 

kelas VIII SMP yang diajarkan pada semester genap di bab ke tujuh. Tujuan akhir 

dari materi ini adalah siswa dapat menulis secara mandiri teks persuasif sesuai 

dengan yang diajarkan untuk kemudian dapat di presentasikan. 

Penelitian ini menggunakan jenis inkuiri terbimbing. Menurut Joyce dan Well 

langkah-langkah yang terdapat pada pembelajaran inkuiri terbimbing meliputi: 

                                                 
72 Suprihatiningrum. h. 164 
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Identifikasi dan menetapkan ruang lingkup masalah, penetapan hipotesis, uji 

rancangan percobaan dan interpretasi data, dan pengembangan kesimpulan.73 

Langkah-langkah yang dilakukan pada materi teks persuasi dengan 

menggunakan pendekatan inkuiri adalah sebagai berikut. 

Pertama,  Pendahuluan guru membuka materi dengan pendahuluan yakni 

cerita pembuka tentang pengalaman yang ada di sekitar siswa atau pengalaman 

yang pernah siswa lakukan terkait dengan materi yang dibahas yakni teks persuasi.. 

Contoh pembuka yang disampaikan kepada siswa adalah seperti: 

“Dalam kegiatan sehari-hari diantara kita pasti pernah ditawarkan oleh 

seseorang untuk membeli barang daganganya, atau kalian pasti pernah 

mendengar seorang calon anggotta legislatif berkampanye dalam kontestasi 

politik” 

 

Pada kegiatan pendahuluan ini juga dibentuk kelompok belajar, tujuan dari 

kelompok belajar ini adalah untuk dijadikan ruang dalam berdiskusi selama 

kegiatan pembelajaran.  

Kedua Merumuskan masalah, pada tahap ini siswa diberikan kesempatan oleh 

guru untuk bertanya dengan seluas-luasnya tentang hal yang berkaitan dengan 

materi teks persuasi, tujuan dari bertanya adalah untuk merumuskan masalah yang 

akan dibahas dalam materi teks persuasi. Setiap pertanyaan selanjutnya dirumuskan 

bersama untuk kemudian siswa mencari jawaban. 

Ketiga merumuskan hipotesis, pada tahap ketiga ini siswa bediskusi secara 

berkelompok untuk merumuskan hipotesis sesuai dengan perumusan masalah yang 

sebelumnya sudah dilakukan, setiap hipotesis yang ditemukan tidak langsung 

                                                 
73 Kiky Chandra Silvia Anggraaini, Model Pembelajaran Inkuiri Terbimbing Dan Keterampilan 

Sosial (Lamongan: Nawa Litera Publishing, 2022). h. 24 
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diputuskan selanjutnya akan dijadikan bahan diskusi untuk menguji jawaban 

dengan kelompok siswa yang lain. 

Keempat menguji jawaban, pada tahap ini setiap kelompok yang sudah 

berdiskusi kemudian mengajukan hipotesisnya untuk kemudian didiskusikan 

dengan kelompok yang lain. Siswa saling melontarkan pendapatnya dan tugas guru 

dalam hal ini adalah menjadi fasilitator dan memberikan arahan pada setiap 

jawaban yang dilontarkan siswa. 

Kelima menarik kesimpulan, pada tahap ini setiap jawaban yang dilontarkan 

siswa berdasarkan rumusan masalah kemudian ditarik kesimpulan sebagai jawaban 

yang tetap. Jawaban yang tetap itulah menjadi acuan siswa dalam berpikir dan 

membuat karya teks persuasi secara mandiri sesuai dengan seluruh materi yang 

telah didiskusikan dan kemudian dipresentasikan didepan kelas dengan segala 

pengetahuan yang sudah didiskusikan selama pembelajaran berlangsung. 

Berdasarkan kegiatan penelitian yang dilakukan, penerapan pendekataan 

inkuiri efektif dalam meningkatkan keterampilan berbicara siswa. Hal itu 

dikarenakan siswa lebih banyak mempunyai ruang dalam mengeksplorasi seluruh 

pengetahuan yang dimiliki dengan mencari sendiri jawaban yang menjadi persoalan 

dalam sebuah pembelajaran. 

2. Besar nilai signifikansi efektivitas penerapan pendekatan inkuiri 

terhadap keterampilan berbicara siswa SMPN 1 Pamekasan. 

Data pada penelitian ini diperoleh bahwa kelas eksperimen bersifat normal 

dan kelas kontrol tidak normal. Hal itu dapat dibuktikan dengan nilai signifikansi 

yang diperoleh pada keIas eksperinen nilai signifikansi (Sig.) 0,059 > 0,05 (normal) 
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dan kelas konrtol nilai signifikansi (Sig.) 0,014 < 0,05 (tidak normal). Berdasarkan 

pada hasil tersebut maka data pada penelitian ini adalah tidak normal. 

Pada nilai uji homogenitas diperoleh bahwa data bersifat homogen. Hal itu 

dapat dibuktikan dengan nilai signifikansi yang diperoleh. Signifikansi nilai 

menunjukkan (Sig.) Based on Mean adalah 0.193 > 0,05 maka data yang diperoleh 

homogen. 

Berdasarkan data hasil penelitian tentang Efektivitas penerapan pendekatan 

inkuiri terhadap keterampilan berbicara siswa SMPN 1 Pamekasan dapat diketahui 

bahwa pendekatan inkuiri efektif untuk meningkatkan keterampilan berbicara siswa 

SMPN 1 Pamekasan. Hal itu dapat dibuktikan dengan nilai signifikansi yang 

diperoleh dalam uji hipotesis statistic nonparametric dengan memakai uji Mann-

Whiteney. Pada hasil uji diperoleh nilai Asymp. Sig. (2-tailed) 0,004 < 0,05. 

Dengan demikian nilai signifikansi Sig. (2-tailed) 0.004 lebih kecil dari 0.05 yang 

berarti Ho ditolak dan (Ha) diterima. 

Keefektifan pendekatan inkuiri terhadap keterampilan berbicara siswa pada 

penelitian ini berkategori sedang. Kategori tersebut diperoleh dari hasil uji effect 

size yang menunjukkan niliai 0.69 yang berarti sedang. Uji effect size ini diperoleh 

dari penggunaan rumus Cohen’s d. 

Berdasarkan pembuktian hipotesis yang dilakukan, maka dapat ditarik 

kesimpulan bahwa pendekatan inkuiri efektif untuk digunakan dalam pembelajaran 

bahasa lndonesia khususnya pada keterampilan berbicara siswa SMPN 1 

Pamekasan. 

  


